


INTRODUCTION
PlanStar is a resource scheduling/planning system.      It will put you in complete 
control of the people, places, and things for which you are responsible.    

Lets clear up some fuzzy terminology quickly.    There are two things that PlanStar is 
not:

- It is not a Personal Information Manager (PIM), because the emphasis on resource 
management is much broader than just managing your own day-to-day tasks.    You can certainly use it for
personal scheduling, however - it will neatly categorize your activities.    Just don't look for a todolist!

- It is also not a 'structured' (or 'active') scheduler, software designed to fit employee hours into a 
workweek for you, like at a fast food restaurant.    Rather, it is designed to be used in an 'unstructured' 
environment, such as management of a staff of professional employees being given ad hoc assignments 
on a variety of projects.    You're in charge.    PlanStar just makes sure you stay straight.

Its design is extremely flexible - it can be tailored to suit any scheduling or logging 
requirement.    By using the unique CrossKey feature, you establish categories of 
events which can later be used to selectively produce lists calendars.

Because PlanStar allows you to select the criteria (types or events, categories, etc.),
you can integrate all of your scheduling needs into one database.    For example, 
you can record personal items such as your favorite football teams schedule with 
business items - you can control which you want to view at any given time!

There is no beginning nor end to the database that you will build with PlanStar.    
Onetime events do not disappear once completed - they remain in the system 
forever, unless you delete them.    Recurring events "wrap" forever, unless you 
delete them, or constrain them to a time period.    

If tracking time and/or money is important to you, PlanStar will handle it.    You can 
easily set up the system to record, list, and total hours and dollars.

Resource utilization can be displayed graphically, in the form of bar and line charts, 
for any combination of CrossKeys and for any period of time!

PlanStar has extensive printing capabilities.    You can tailor and print monthly, 
weekly, and daily schedules, or ad hoc event listings, for any or all of your resource 
categories.

                                                                                                                            

Version 2 is released in coincidence with the release of our new contact manager, 
CallStar.    If you have CallStar, you can link individuals or lists of people to PlanStar 
events!    Take a look at the demo on the HELP MENU.    Give us a call for more 
information!    See also Linking to CallStar.



* * * * *

That's PlanStar, briefly...a system that you'll wonder how you lived without!

P.S. As a member of the Association of Shareware Professionals, we are 
committed to the principle of providing quality software and giving you, the user, 
plenty of opportunity to make a good evaluation.    All we ask is that you consider 
the amount of work that we put into PlanStar, and remember your responsibility as 
a shareware user: if it does the job for you, do the right thing! See SHAREWARE 
VERSION



INSTALLATION
If youre able to view this HELP file, you have already installed PlanStar.    It has a standard 
Windows SETUP program that makes sure all the files get to their proper places.

You must be advised that this is not a network version!    It will work on a network in single-user
write/many-user read mode*, but will not support multi-user write!    A network version is in the 
works.    Please contact us for more information.

The most important consideration is this:    if you intend to link PlanStar with CallStar, they 
MUST be located in the same subdirectory.    When you ran the SETUP program, the default 
subdirectory was C:\PLANSTAR, with a message to this effect.    If you changed this for any 
reason, and someday wish to install CallStar, you need to be aware of this fact about colocation.

*To load on a network as described above, you must install individual copies to each 
workstation.    In the ICON PROPERTIES, set the WORKING DIRECTORY to the file server 
address, where the data files will be stored.



SHAREWARE VERSION
This is a FULLY-FUNCTIONAL evaluation copy.    You are entitled to an evaluation period of 90 
days or entry of 100 ONETIME events, whichever is greater.    This means that, even if you
wait six months before you begin trying it, it will continue to function until 100 events have been 
entered.

But...!

PlanStar is unique in that some of its value doesnt present itself - such as the ability to present 
historical summary reports and resource utilization charts - until after a longer period of time 
than most software products.    For that reason, we have a procedure for getting you an 
extension!    If, after your trial period is up, you would like more time to evaluate, just contact us 
(see TECHNICAL SUPPORT) and we will give you a number that will give you another 90 
days and 100 events!    And we will do this as many times as you like!



HOW PLANSTAR CAN BE USED 
You will find that PlanStar can be tailored to suit almost any task for which you are 
required to associate events with time.    This could be anything from a teenager's 
date book to a complex management system, recording various activities by 
individuals on many different tasks at many different locations, for instance.

If you do manage people, wouldn't it be great to have a system that could produce 
a schedule of upcoming assignments for a single employee, or a group of 
employees, or all employees, that you could post or hand out; that would ensure 
that there were no overlaps, or sending someone to Walla Walla who is supposed to 
be in Tallahassee; that would, at the end of his annual evaluation period, display a 
recap of an employee's every activity for the year, in a few seconds?    And at the 
same time, keep a tab of hours and/or dollars being expended by any or all 
employees, for any or all activities, and for any or all projects?

Well, here it is...

SEE ALSO:
Using PlanStar As a Scheduler
Using PlanStar As a Logging Tool
Using PlanStar As a Money Manager



USING PLANSTAR AS A SCHEDULER
Any number of resources can be scheduled with PlanStar. Simply establish a good 
list of CrossKeys, and 'tag' them to events as the events are planned.

Here are a few examples:

(1) You are the manager of a staff of four employees: Bob, Carol, Ted, and Alice.    
They provide documentation support as required to a number of projects for your 
company.    They attend planning meetings and conferences, and must travel to 
various company locations.

Your CrossKey list could look something like this:

Bob
Carol
Ted
Alice
Davidson & Co.
Magna-Graphics
Anderson Project
Travel Status
Meetings
Conferences

When you assign Ted to attend a meeting on the Anderson Project in Atlanta on June
15-17, PlanStar will first verify that Ted is available for that assignment during that 
period.    If there is a conflict, it will tell you what the conflicting event is and give 
you the option of assigning someone else, changing the time, or overriding the 
conflict, whatever it takes to best get the job done.    The point is that you, the 
manager, make the decision... that's your job!

Now, after other events have been entered, you can use SELECTION CRITERIA 
to:

- print a hard copy calendar of Ted's assignments.

- produce a listing of all "Travel Status" events, when your budget manager 
asks you to project known travel requirements.

- produce a schedule of events for the Anderson Project.

(2) In your spare time, you assist the local Little League baseball program.    You 
could use PlanStar to produce an overall schedule and individual schedules with 
only the games for each team, assign the games to different playing fields, and 
capture the results, if you want.

(3) You run an agency offering short-term rentals of resort houses and condos.    Set 



up your CrossKey list to include each property.    You may use the amount fields to 
project income.    When prospective renters inquire with a desired time period and/or
property, you can quickly "click up" the availability.    As the properties are rented, 
record the renters name and other pertinent information as a PlanStar event - it 
won't let you rent the same property twice for the same period!    If a renter says 
that he wants to rent the same condo as last year, but doesn't remember which one
it was, use the string search function on the SELECTION CRITERIA screen to locate 
the event by entering the person's name.

I could go on here with ideas for how PlanStar can organize your life, but as you will 
see, the possibilities are enless!    You can schedule any person, place, thing, or 
activity with PlanStar!



USING PLANSTAR AS A LOGGING TOOL
Since PlanStar retains all data, it can serve as a logging system, instead of, or in 
conjunction with its scheduling capabilities.    In other words, events can be entered 
as they occur.    If it's important to you to record significant happenings in the course
of your business, just jot it down as a PlanStar event.    Then, at any future time, you
can quickly pinpoint the event and its exact date and time...or summarize, using 
combinations of CrossKeys to extract the information.

You can combine scheduling and logging capabilities.    Plan a meeting, then, when it
occurs, edit the event description with the minutes of the meeting, action items, 
etc.



USING PLANSTAR AS A MONEY MANAGER
PlanStar can be used in simple money management in conjunction with its 
scheduling and logging capability.    

Your job calls for you to plan tasks for which there is a cost estimate when 
scheduled, and an actual cost when the task is completed.    Use PlanStar 
PREFERENCES to change the first of its three amount field names to ESTIMATED
COST and the second to ACTUAL COST.    Use the SELECTION CRITERIA screen
to add the two fields to your EventLog display.

When entering scheduled tasks, record the estimated cost.    When the task is 
complete, edit the event to add the actual cost to the event record.    Zero the 
estimated field if you want.    

You may now use SELECTION CRITERIA to capture and total this information for any 
period of time.



SOME FRIENDLY PLANSTAR FEATURES
PlanStar is designed to be "user-friendly" as well as flexible.    Any action can be 
selected from a row of ACTION BUTTONS which appear, as appropriate, across 
the top of the EventLog and calendar screens.    The buttons are consistent; they 
mean exactly the same on all screens, wherever they appear.

While PlanStar has a tutorial and a complete 'help' facility to assist the new user, 
it also has a QUICK HELP PANEL in the lower right corner of most screens, which
provides mouse-sensitive help.

You may select any action to be taken from the EVENTLOG MENUS, or by using 
the ACTION BUTTONS as described above.    There are also HOT KEYS available for
quickly jumping to the more often-used functions and screens of the system.

Entry of date and time fields is made easier and quicker by the use of SPIN 
BUTTONS.    These are small arrows placed just to the right of the field that let you
change the contents of the field by clicking with the mouse.



ACTION BUTTONS
Here are the PlanStar action buttons and their functions:
                    

Use them to quickly jump to the PlanStar function desired.



QUICK HELP PANEL
On the bottom of most PlanStar screens is a panel that provides quick, mouse-
sensitive help to the user.    As you move the mouse cursor over an item on the 
screen (without clicking), or use the TAB key to move about the screen, the panel 
displays a short description of the item's function.

Of course, if you need more help, PlanStar features full context-sensitive help.    Tab 
to an item on the screen and press F1



HOT KEYS
All hot keys are used in conjunction with the control (CTRL) key.    Following is a list 
of the hot keys, and the functions or screens they will call:

                                   CONTROL 
FUNCTION or SCREEN                 KEY AND
------------------                 --------
Selection Criteria S
CrossKey Maintenance C
Preferences    P
Add Event (Blank EVENT WORKSHEET)  A
Event QUICKVIEW Window  Q
EVENT WORKSHEET (for selected event) E
Year Calendar Y
Month Calendar M
Week Calendar W
Today's Schedule D
Resource Utilization Charts R
Exit PlanStar X



SPIN BUTTONS 
Spin buttons are provided with various date and time fields in PlanStar.    Here is an 
example of spin buttons for a date field:

                          

In the example, by clicking the green UP arrows with the mouse, you increment the 
associated month (M), day (D), or year (Y); the DOWN arrows decrement.



EVENTLOG MENUS
The EventLog screen has a dropdown menu bar across the top, with the following 
main menu selections:

File Menu
Event Menu
View Menu
Print MenuOptions Menu
Help Menu



YOUR PLANSTAR DATABASE
PlanStar is forever.    It has no beginning nor end.    Every event that you enter 
remains forever, unless you manually delete it.    The disk space requirements are 
very small compared to capacities being offered on computer systems today.    

CrossKeys are NEVER deleted, because they may relate to past events - which, as 
stated above, should also never be deleted.

NOTE: There is no "load-time overhead" for one-time events, because a sequential 
read of the database is not required - you set the time period for the EventLog 
and that's all it has to read. The number of recurring events, however, does affect 
the load time, because PlanStar has to see if each event recurs in the time period 
you have selected. 

SEE ALSO:
Maintaining your CrossKey List
Working with PlanStar Events
Importing EventLog Data
Exporting EventLog Data
Backup and Restore
PlanStar Data Files



MAINTAINING YOUR CROSSKEY LIST
Click on the CrossKey action button to access the CROSSKEY MAINTENANCE 
screen.    There are several options available to you in maintaining your list.    You 
may:

- Add a new CrossKey
- Modify an existing CrossKey
- Toggle the status of a CrossKey (active/inactive)
- Move a CrossKey to another place in the list order

WHAT ARE CROSSKEYS, ANYWAY?

CrossKeys are the heart-and-soul of PlanStar - they give you the ability to categorize
the events you enter, so that later you can easily select them for display and print.   
This is the feature that makes PlanStar a resource manager, as opposed to a 
personal scheduler.

The term CrossKey stands for CROSS-reference KEYword.    It's given a generic 
description because you, the user, create them to suit the scheduling task at hand.   
And they can be used for just about any purpose.

CrossKeys are used to define the who, what, and where of your task.    The job is 
made easier to understand because all are placed into a single list.    When you 
enter a new event, you may 'tag' the event with as many CrossKeys as are 
necessary from the list - people, places, things alike!

The simplest use would be for the management of a staff of employees.    Simply 
enter each employee's name as a CrossKey, then activities of your business that 
relate - such as projects on which the employees are working.    This will allow you to
come back at some time in the future and quickly identify or summarize who 
worked on what, and when!

The bottom line is this: how you set up your CrossKey list will determine the value 
you will get from PlanStar.    So just give some thought to how you do business, build
a good list, and go to work!



ADDING CROSSKEYS
When the ADD button is selected on the CROSSKEY MAINTENANCE screen, an input 
box appears, letting you enter the new CrossKey.    It will be added to the bottom of 
the list.

PlanStar will not accept a CrossKey that already exists in your list.



MODIFYING CROSSKEYS
While CrossKeys cannot be deleted, you are free to change them as you see fit.    
Simply highlight the CrossKey in the list and select the MODIFY button.    The 
CrossKey will appear in an input box for you to edit.

If the new CrossKey already exists in your list, PlanStar will not accept it.



ACTIVATING AND DEACTIVATING CROSSKEYS
The ACTIVE/INACTIVE button toggles the status of the highlighted CrossKey.

While CrossKeys cannot be deleted, they may be deactivated as you see fit.    The 
word "INACTIVE" is attached to the CrossKey, and will not appear in other CrossKey 
lists throughout the system.    They will, however, continue to be appear attached to 
events in the EventLog and calendars, followed by the letter "I" in parentheses (I) 
to signify that the CrossKey is inactive.

There is a reason for not deleting CrossKeys.    Because PlanStar retains all data 
entered, the relationship between an event previously entered and its associated 
category cannot be eliminated.    For instance, your database contains many events 
which you have associated with an employee CrossKey, ROBERT.    Even if Robert 
leaves your employ, those events still exist in your database.    

So, instead of deleting, simply deactivate the CrossKey ROBERT in your CrossKey 
list so that it doesn't appear.    At some future time, if you ever need to summarize 
old events for Robert, you can activate it long enough to do that, then re-deactivate 
it!



MOVING CROSSKEYS IN YOUR LIST
You may reorganize your CrossKey list at any time.    You may wish to move little-
used CrossKeys to the bottom, for instance.    To do this, simply highlight the 
CrossKey you wish to move, then select the button MOVE.    You will be instructed to
select the point in the list where you wish the CrossKey to be placed.



WORKING WITH PLANSTAR EVENTS
SEE TOPICS:

Event types
The Event Worksheet
Using the Actual Hours Field
Using the Money Fields
Conflict-checking



EVENT TYPES
PlanStar accepts two general categories of events: onetime events and recurring 
events.    Onetime events are just as they sound - they occur only once.    Recurring 
events are events which repeat on a regular basis, like a birthday or anniversary.    
They are entered into the system once, and PlanStar takes care of the rest - they 
repeat forever, or as long as you want them to.

CHARACTERISTICS OF ONE-TIME EVENTS

- They may be for an exact point in time.    For instance, you may have a 
requirement that something be finished by noon on Friday.    

- They may contain a clock time, or they may not.    A two-hour meeting would
certainly require a beginning and ending time, but an event specifying that Tuesday 
is a holiday would not.

NOTE: if you are accumulating time associated with CrossKeys (see USING THE 
ACTUAL HOURS FIELD), you must specify the beginning and ending time of day.

- They may be for a single day, or for a range of days.    If you are scheduled 
to be on a business trip for a week, you would enter the first and last days of the 
trip.    

NOTE: if you specify a beginning and ending time, it applies to EACH DAY.    

NOTE: if the event extends over a Saturday and/or Sunday, you will have the option 
of having those days appear in your EventLog and calendars, by selecting or de-
selecting the INCLUDE WEEKENDS check box.

- They may be associated with one or more CrossKeys, or none at all.

CHARACTERISTICS OF RECURRING EVENTS

- They are entered into the CrossKey database only once.    When PlanStar 
loads the EventLog or a calendar, it tests each recurring event to see if it falls within
the selected timeframe.

- They may be for a floating or fixed period of time.    A floating event will 
display at every possible recurrence during the SELECTION CRITERIA 
timeframe; a fixed event is limited to recur only during a period set specifically for 
the event.    For instance, if you have an event scheduled to recur every Tuesday 
from March 1 through May 31, if your EventLog SELECTION CRITERIA was set for the
range February 1 to March 31, the event would appear only during March.

- Recurring events cannot be selectively changed.    If you enter an event to 
recur every Tuesday morning at 9 a.m., there is no procedure for changing the day-
of-the-week or the time on a onetime-only basis.    (A future version of PlanStar may 



indeed have this capability - it's being looked at!)

THE RECURRING EVENT TYPES

Following are the nine recurring event types:

DAILY: Recurs every day (you may select or omit certain weekdays) at a specified 
time.

WEEKLY: Recurs on the same day every week.

BIWEEKLY: Recurs on the same day of the week, every other week.    

NOTE: biweekly events must be fixed, because that is the only way PlanStar can 
determine when it should begin recurring.

MONTHLY: Recurs on the same day every month.

NOTE: if a month does not have the specified day, it is ignored, i.e. an event that 
recurs on the 31st would appear only for January, March, May, July, August, October,
and December.

MONTHLY VARYING: Recurs on a specific occurrence of the same weekday every
month, i.e. the third Thursday of the month.

QUARTERLY: Recurs on the same day every three months.

SEMI-ANNUAL: Recurs on the same day every six months.

ANNUAL: Recurs on the same day every year.

ANNUAL VARYING: Recurs on a specific occurrence of the same weekday in the 
same month, every year, i.e. the fourth Sunday in August.



THE EVENT WORKSHEET
The EVENT WORKSHEET screen is where you can add events, change event 
data, or remove events from your database.    You may call this screen from
the EventLog or any of the calendars, except the Year Calendar.

When the button named ADD EVENT is selected, a blank worksheet is presented, so 
that a new event may be entered.    When an existing event is selected from the 
EventLog or a calendar, the worksheet appears with the data for that event.

                                                                                                                              

After adding a new record, you have the option of returning directly to the EventLog 
or calendar screen from which the worksheet was called, or displaying the 
QUICKVIEW screen.    This latter option is introduced so that you can immediately 
create a CallStar link after adding a new PlanStar event.



ADDING EVENTS
Selecting the ADD EVENT button on the EventLog, Month Calendar, Week 
Calendar, or Day Calendar screens will produce a blank EVENT 
WORKSHEET.    This is where you will record all pertinent data about a new event. 
You must, at a minimum, enter an event type, a date, and a description of the 
event.    You may optionally enter a beginning and ending time, associated 
CrossKeys, and up to three amount fields.

A frame with the caption WHEN appears at the center top of the EVENT 
WORKSHEET screen, wherein you must establish the date(s) that the event will 
occur (or recur).

SETTING THE DATE FOR A ONETIME EVENT

You may edit the date fields using standard date notation, or quickly set by using 
the green spin buttons to the right of the dates, a set of up and down arrows for 
adjusting the month, day, or year.    When using the spin buttons, the TO date 
"tracks" the FROM date - any change you make to the FROM date will automatically 
change the TO date.    

You may also set the dates by selecting the CALENDAR button in the lower right 
corner of 
the WHEN frame.      

USE OF THE SPIN BUTTONS OR POP- UP CALENDAR IS RECOMMENDED SINCE IT 
ENSURES VALID DATES ARE ALWAYS ENTERED!

Selecting the TODAY button (above the FROM date) will change the FROM date to 
the current date. 

The box to the right of the label "Days:" will show the number of consecutive days 
you are entering for the event.    This is for information purposes only.

When you enter a date range that extends over one or more of the weekend days 
(Saturday or Sunday), a check box will appear asking you if you want to include 
weekends.    If you indicate YES, the event will appear in the EventLog and 
Calendars on those weekend days; if NO, the event will not be displayed.    For 
example, if you schedule an employee for a two-week training course in which he is 
actually only in class from Monday thru Friday, selecting NO will ensure that the 
event is only displayed for weekdays.

SETTING THE DATE FOR A DAILY EVENT

- Select the days of the week that you want the event to recur.

SETTING THE DATE FOR A WEEKLY EVENT



- Select the one weekday on which you want the event to recur.

SETTING THE DATE FOR A BIWEEKLY EVENT

- Enter a fixed date range for a biweekly event.    PlanStar uses the beginning 
date to establish the pattern of repetition for the event.

SETTING THE DATE FOR A MONTHLY EVENT

- Enter the day of the month on which you want the event to recur.    You may 
use the spin buttons to quickly set the day.

SETTING THE DATE FOR A MONTHLY VARYING EVENT

- Select the monthly variance number (the number of times the weekday 
occurs in the month) from the dropdown box on the left.    This may be the First 
through Fifth, or Last occurrence in the month.

- Select the weekday from the dropdown box on the right.

SETTING THE DATE FOR A BIMONTHLY, QUARTERLY, SEMI-ANNUAL, OR 
ANNUAL EVENT

- Select the month(s) of the year that you want the event to recur from the 
choices in the dropdown box.    Then enter the day of the month, using the spin 
buttons if desired.

SETTING THE DATE FOR AN ANNUAL VARYING EVENT

- Select the monthly variance number (the number of times the weekday 
occurs in the month) from the dropdown box at the top left.    This may be the First 
through Fifth, or Last occurrence in the month.

- Select the weekday from the dropdown box at the top right.

- Select the month of the year that you want the event to recur from the 
choices in the third dropdown box.    

NOTE: For all of the recurring events above, see EVENT TYPES for an explanation 
of FLOATING and FIXED events.

SETTING THE TIME

An event time is not required for an event - the TIME box in the upper right corner 
of the Event Worksheet gives you the option of recording time or not.    

NOTE: If you do not enter a time, the actual hours are not recorded.



You may change the default time setting for a new event in PREFERENCES, to 
one of the following:

- No time.

- Time set to the current time of day.

- Time set to 8:00 AM.

The ACTUAL HOURS field is automatically set to be the difference between the 
beginning and ending time.    You may manually adjust this value if necessary. 

TAGGING CROSSKEYS TO THE EVENT

Your current CrossKey list appears on the right side of the worksheet.    Select all 
the CrossKeys that apply to the event. The TOGGLE ALL button will mark or 
unmark all CrossKeys, depending upon the status of the first CrossKey. 

ENTERING THE MONEY FIELDS

If you are using PlanStar to track dollar values, enter all that apply to the event 
in the three boxes below the CrossKey list on the right of the worksheet.



POPUP CALENDAR
The popup calendar on the EVENT WORKSHEET screen is there to provide you 
with a quick look at the month and ensure that dates are entered properly.    

It is available for onetime events only.    To activate, select the button labeled 
CALENDAR in the lower right corner of the WHEN frame.    This little calendar will 
appear:

You will be instructed to click the beginning date, then a second click for the ending 
date.    NOTE: You must click twice, even if the event begins and ends on the same 
day.

You may move forward or backward one month by clicking the LEFT or RIGHT 
arrows at the top of the calendar window.



MODIFYING EVENTS
To change an existing event, simply double-click on the event in the EventLog, 
Month Calendar, or Week Calendar, or single-click on the event in the Day 
Calendar.    This will cause the EVENT WORKSHEET to appear for this event.    

You may then modify any data about the event, except the EVENT TYPE.

See ADDING EVENTS for detailed information about the EVENT WORKSHEET.



DELETING EVENTS
It is recommended that events never be deleted except in the case of scheduled 
events that were cancelled.    PlanStar is designed to give you complete access to 
your past, as well as your future.    

To delete an event, simply double-click on the event in the EventLog, Month 
Calendar, or Week Calendar, or single-click on the event in the Day 
Calendar.    This will cause the EVENT WORKSHEET to appear for this event.    

A DELETE button will appear at the lower right of the screen.    Selecting this button 
will remove the event from your database.    



USING THE ACTUAL HOURS FIELD
If (and only if) a beginning and ending time is entered when recording an event, an 
actual hours field is associated with that event for each day an event occurs.    (In 
other words, if a onetime event is scheduled to occur from Monday through 
Wednesday in a given week, from 9 a.m. to 11 a.m., then the actual hours field of 2 
hours represents 2 hours on EACH of the three days.)    

For recurring events, the actual hours represents the elapsed time for ONE 
OCCURRENCE of the event.

The actual hours field is automatically set to be the time span between the 
beginning and ending times, but it can be adjusted if necessary.    For instance, if an 
event is entered which will begin at 8 a.m. and end at 5 p.m., you may wish to 
change the actual hours field from 9 hours to 8 if you don't want to include an hour 
for lunch.

The EventLog detail line can be tailored to include the actual hours field.    When
included, a total of the actual hours for the selected EventLog will appear beneath 
the column.



USING THE MONEY FIELDS
PlanStar has three amount fields associated with every event, which may be used 
for any purpose.    The PREFERENCES screen will let you rename the fields to your
choosing.

When recording an event, enter the dollar amounts as necessary in the appropriate 
field on the EVENT WORKSHEET.    

The EventLog detail line can be tailored to include any or all of the money fields.
When included, the columns will be totaled beneath the EventLog.

The amounts will also be used to produce Resource Utilization charts, i.e. 
dollars per month per CrossKey.



CONFLICT-CHECKING
When a new event is entered, PlanStar quickly scans your database to see if there 
are any events in the SAME DATE/TIME RANGE, that are associated with one or more
of the SAME CROSSKEYS.    If it finds any, a warning screen will appear, and you will 
have the option of saving the event anyway, or returning to the EVENT 
WORKSHEET screen to make changes.

Conflict-checking will also occur when a change is made to an event affecting its 
dates, times, or CrossKeys.



IMPORTING EVENTLOG DATA

                                                                                                                                    

Due to popular demand, it is now possible to import bulk data to your PlanStar 
database.    The concern here, and the reason it was not implemented in an earlier 
version, is that your import file must be perfect or you risk doing considerable 
damage to your data files!    We have taken every effort in the code to avoid this, 
but you cant code for every possible situation.

In that regard, the watchword is BACKUP.    Before you attempt to import data, do a 
DOS copy of all of your .PS1 files to a backup location.    Then, if something goes 
awry, you can always copy them back and retry!

Your import data file must be in the following format:

*{beginning date},{ending date},{beginning time},{ending time},{event 
description},{amount one},{amount two},{amount three}

And conform to the following rules:

Each set of data describing an event must have as its first item the beginning date 
PRECEDED BY AN ASTERISK (*) WITH NO SPACE IN BETWEEN.

The date and time fields are in your Windows default date format, such as 
DD/MM/YY and HH:MM AM.

If the beginning date and ending date are the same, you may leave the ending date 
blank, with its place marked by a comma.    The same is true for the beginning and 
ending times.

Because this is a Comma-separated variable (CSV) file, THERE MUST BE NO 
COMMAS IN THE EVENT DESCRIPTION!!!!    There can be seven, and seven only, 
commas in each event set.



EXPORTING EVENTLOG DATA
PlanStar will let you create a comma-separated variable (CSV), ASCII file 
representation of a selected EventLog.

Simply use SELECTION CRITERIA to produce the EventLog you wish to export, 
then select EXPORT from the dropdown FILE MENU.    

You will then be asked to select the fields you wish to include in the file.    SELECT 
THE FIELDS IN THE ORDER YOU WANT THEM TO APPEAR IN THE FILE.    As you select 
the fields, the order will appear in the box at the bottom of the window.    If you wish 
to remove an item, simply re-click it.

When you select the button labeled CONTINUE, a file named EXPORT.DAT will be 
created in your PlanStar subdirectory, which may then be used as input to any other
software program that will import a CSV file.

If you select the item "CrossKeys (indices)" to be included in your CSV file, this will 
produce an indexed list of your CrossKeys, using a 3-character mask separated by 
an "AT" (@) sign.    In other words, selecting three CrossKeys whose sequence 
numbers are 3,7 and 12 will produce the string:

@    3    @    7@ 12

Another file with the name CROSSKEY.NDX will be simultaneously generated with a 
cross-reference of the CrossKey sequence numbers and names.

NOTE: All commas in your data will be replaced by semicolons in the CSV file!



BACKUP AND RESTORE
This feature is intended for more than one purpose.    You may wish to safeguard 
your data offline (although simply doing a DOS copy of your data fileswould do 
the same).

The primary purpose is to restore damaged database linking.    PlanStar is very 
heavily indexed to speed up the search process as much as possible.    If power to 
the computer should be interrupted when it is in the process of saving data, a 
damaged link can occur.    Some strange computing will result.

If you get a error such as "invalid path" or "file not found", I recommend you create 
a BACKUP file, followed by a system RESTORE.

When you select BACKUP or RESTORE, a window will appear asking you to select 
the path to your backup file.    

NOTE: The backup file produced is in ASCII format, therefore you can easily view it.   
I advise extreme caution, however, in making any modifications to the file, since the
RESTORE function is expecting a specific format.    Do a DOS backup (see above) 
first. 
 



PLANSTAR DATA FILES
When examining your PlanStar DOS subdirectory, you will notice that a number of 
files have been generated with a .PS1 extension.    These are your data files, and 
their names are:

MASTER.PS1
LOG.PS1
LOGINDEX.PS1
RECUR.PS1
SETUP.PS1
DESC.PS1
WHAT.PS1
WHATPTR.PS1

These files are all required for your database, and should not be individually 
moved or deleted.    If they are deleted, your PlanStar system will restart from 
scratch!

They can be copied AS A GROUP (*.PS1) to another computer if desired.



DIFFERENT WAYS TO VIEW YOUR DATA
PlanStar lets you choose the way you want to view your data.    For a quick look at 
the information about a single event, there is a pop-up QUICKVIEW window.    If 
you want to look at an event with the idea that you may want to modify it in some 
way, you may select the EVENT WORKSHEET screen. 

After you have entered many events, you may choose to view them in chronological
order in the EventLog, Month Calendar, Week Calendar, or in the Day 
Calendar.  

While the Year Calendar does not display events, it is the best way to launch 
other calendars when skipping around over a wide timeframe.

When viewing either of the year, month, and week calendars, you may elect to view
any of its subordinate calendar screens.    For instance, when viewing the Year 
Calendar, you may view any month, week, or day in that year.

The Month and Week Calendar will let you click up the QUICKVIEW window for an 
event;      the Month, Week, and Day Calendar will pop up the EVENT WORKSHEET.



THE QUICKVIEW WINDOW
The QUICKVIEW window is a pop-up display of all information about a single event.    
It is accessible from the EventLog, the Month Calendar, and the Week 
Calendar.

The QUICKVIEW window cannot be used to change event data.    The EVENT 
WORKSHEET is used for this purpose.

                                                                                                                        

You may now create links to individuals or groups of people outside your 
organization, by integrating CallStar, the new contact manager from ComputerEase. 
The passageway to these links is through the QUICKVIEW window.    On the right side
of the screen, the panel labeled Link to CallStar, will contain either one of two 
buttons: CREATE LINK or EDIT LINK.    When no link has yet been made for an 
event, the CREATE LINK button will be visible; when a link already exists (there can 
be only one link per event), the EDIT LINK alone is visible, along with a scrollable 
display of the person(s) on the list.    Selecting either of these button will summon 
the LIST MANAGER window, where you can build or modify the link list.    See 
Linking to CallStar.



THE EVENTLOG
The EventLog is the main PlanStar screen.    It is a scrollable, chronologically-ordered
list of events selected from your database by setting the SELECTION CRITERIA., 
Here in the EventLog, and the calendar screens as well, PlanStar lets you, the user, 
specify whether you want to look at all of the events you have entered for a certain 
time period, or just certain types or categories.

If you have chosen to select certain types of events, or maybe a combination of 
different CrossKeys, the criteria you have set will appear in a static display on the
EventLog screen; if you have chosen to display all types of events for a time period,
the display will not appear, and the EventLog will expand to fill a larger portion of 
the screen.

From the EventLog you can call any other PlanStar process, either via ACTION 
BUTTONS or the menu.

Across the top of the EventLog screen is the PlanStar menu choices, from which you 
may choose the File Menu, the Event Menu, the View Menu, the Print 
Menu, and the Help Menu.

Below the menu bar are the action buttons,    with which you may call the 
SELECTION CRITERIA screen, the CROSSKEY MAINTENANCE screen, the Year 
Calendar, the Month Calendar, the Week Calendar, the Day Calendar, 
the Resource Utilization Charts , or the Preferences screen.    
The PRINT button, when selected, will load the PlanStar PRINT MODULE, from 
which you can print the current EventLog.    

The EXIT button, when selected, will cause PlanStar to close all files and terminate.

The EventLog detail line can be tailored to include or exclude the following fields: 
the beginning time of an event, the actual hours recorded for the event, or any 
combination of the three amount fields.    Changing the EventLog fields takes 
place on the SELECTION CRITERIA screen.    If the hours or amount fields are 
included on the EventLog line, the columns are totaled for all events in the 
EventLog.

                                                                                                                          

When a link is created between a PlanStar event and a CallStar list, the small 
column at the far left of the EventLog line will contain a small C.    See Linking to 
CallStar.

Selecting the Add Event button on the EventLog will produce a blank EVENT 
WORKSHEET.



There is a mouse-sensitive Quickhelp Panel in the lower right corner of the 
screen.



SETTING THE SELECTION CRITERIA
The SELECTION CRITERIA screen allows you to build an EventLog,    Month 
Calendar,    Week Calendar, and/or Day Calendar, with the types of events 
you choose, for any combination of CrossKeys.    You also establish the date 
rangefor the EventLog on this screen, and tailor the EventLog detail line, if 
you choose.

The SELECTION CRITERIA action button appears on all of the above screens, so 
you may easily access it.

A first look at this feature may be slightly bewildering!    What this does, however, is 
give you complete control over your PlanStar system.    You can extract every 
conceivable combination of event types, dates, and CrossKeys, letting you create 
innumerable views of your data.

ALL OR SELECTED EVENTS 

If you select the ALL button the EventLog and calendar screens will display all 
events in the database which fall in the appropriate time period.

If you select the SELECTED button, you may then include certain major categories 
of events, and/or select from your CrossKey list, as follows:

When ALL events are being displayed, the SELECTION CRITERIA action button on the

EventLog and calendars will be 

When SELECTED events are being displayed, the SELECTION CRITERIA action button

on the EventLog and calendars will be 

INCLUDING MAJOR CATEGORIES OF EVENTS

You may choose to include either or both (but at least one) of ONETIME or 
RECURRING events.    You may choose to include either or both (you must 
choose at least one) of NON-CROSSKEYED or CROSSKEYED events.

By including or excluding these four major event categories, you can group events 
in a wide variety of combinations.

If you have chosen to include CROSSKEYED events, your CrossKey list will be 
displayed, from which you may choose.

By marking or unmarking combinations of CrossKeys here, coupled with the 



operators ALL, OR, AND, and EXCLUSIVE, you can further define your event 
groupings in an almost endless number of combinations.    Here's an explanation of 
the operators:

ALL (applies only when one CrossKey has been marked in your list):    This means 
that all events will be selected from your database that include the CrossKey.

OR (applies only when more than one CrossKey has been marked):    This means 
that events will be selected that include ANY of the marked CrossKeys.

AND (applies only when more than one CrossKey has been marked);    This means 
that events will be selected that include ALL of the marked CrossKeys.

EXCLUSIVE: This means that events will be selected that include ONLY the marked 
CrossKey(s).

Here is an example of the different ways you can select by CrossKey.    Suppose you 
have the following events in your database, with their associated CrossKey lists:

[BOB] Event# 1
[BOB, CAROL] Event# 2 
[BOB, TED] Event# 3
[CAROL, TED] Event# 4
[BOB, CAROL, TED] Event # 5

On the SELECTION CRITERIA screen, if you mark BOB and the operator EXCLUSIVE,
you will get event# 1 in your EventLog or calendar.

If you mark BOB and the operator ALL, you will get events # 1, 2, 3, and 5.

If you mark BOB and CAROL, and the operator OR, you will get events # 1, 2, 3, 4, 
and 5.

If you mark BOB and CAROL, and the operator AND, you will get events # 2 and 5.

If you mark BOB and CAROL, and the operator EXCLUSIVE, you will get event # 2.

The TOGGLE ALL button will mark or unmark all CrossKeys in the list, depending 
upon the status of the first one.

When the SELECTION CRITERIA screen is called from the EventLog, the right side of 
the screen will be displayed on which you can (1) establish the time period for the 
EventLog, and (2) tailor the EventLog line.

ESTABLISHING THE TIME PERIOD

Enter the beginning and ending dates for the period by either editing the date 
fields, or by using the green spin buttons justto the right of the fields.    There are
three of them, one each for quickly incrementing or decrementing the month, day, 



and year fields.

SEARCHING BY CHARACTER STRING

You may have a need to scan through your database to find a particular character 
string within the EVENT DESCRIPTION.    If so, establish all the other parameters 
that apply - date range, event types, etc. - then enter the character string into the 
text box labeled SEARCH STRING.    When you CLOSE the SELECTION CRITERIA 
screen, PlanStar will create the EventLog and/or calendars with only those events.

SAVING AND RESTORING THE DEFAULT CRITERIA

The SAVE SETTINGS button can be selected if you want PlanStar to automatically 
load the EventLog and calendars with the displayed criteria setting.

Then, if you have made temporary changes to produce ad hoc lists, you can select 
the RESTORE SETTINGS button to recall the default criteria.



TAILORING THE EVENTLOG LINE
If the SELECTION CRITERIAscreen is called from the EventLog, you may 
optionally add the following to the EventLog detail line:

Event beginning time
Event actual hours
Any combination of the three amount fields.

Simply check the box(es) as appropriate.    The settings will be saved along with the 
other criteria by selecting the SAVE SETTINGS button.



FILE MENU
You may select the following actions from the File Menu:

Import
Export
Backup Data Files
Restore Data Files

Exit                         Terminates PlanStar



EVENT MENU
You may select the following actions from the Event Menu:

Add New Event
Quickview Event
Event Worksheet



 VIEW MENU
You may display the following from the View Menu:

Year Calendar
Month Calendar
Week Calendar
Todays Schedule
Resource Utilization Charts 



PRINT MENU
Selecting the Print Menu gives you several options:

Today's Schedule
EventLog
Year Calendar
Month Calendar
Week Calendar

Selecting any of them does the same thing - it loads the PlanStar PRINT MODULE, 
which is the central point for all printing in the system.    There, you can actually 
select    any of the above options for print.    The selection you made, however, is 
already set when you get to the print module.



OPTIONS MENU
The Options menu has the following selections:

Selection Criteria
CrossKey Maintenance
Preferences



HELP MENU
The Help menu has the following selections:

Contents          Help file Table of Contents
Search            Help file search function
How to Use Help   Help on help
CallStar Demo
How to Order
Technical Support
Need More Evaluation Time?Tutorial

About PlanStar    Info about PlanStar and ComputerEase



THE CALENDARS
PlanStar provides four levels of calendars: 

-    Year Calendar
-    Month Calendar
- Week Calendar
- Day Calendar.

The latter three provide various levels of event details (the Year Calendar does not 
display events at all).

Some of the calendars can call the EVENT WORKSHEET; some can call the 
QUICKVIEW window as well.    



YEAR CALENDAR
The year calendar is a display of all twelve months of a selected year.

Each monthly calendar on the screen is topped by a button with the name of the 
month.    Selecting that button will display the appropriate Month Calendar.

By single-clicking on a date, you can display its Day Calendar; by double-clicking 
on a date, you can display the Week Calendar for the week containing that date.

OTHER ACTIONS YOU MAY TAKE:

- Select the LEFT or RIGHT arrow buttons at the top to move backward or 
forward one year.

- Edit the year field at the top to "jump" to a more distant year.

- Printan image of the year calendar by selecting the print button.

- You may access and reset PlanStar PREFERENCES.

- Return to the previous screen by selecting the EXIT button.



MONTH CALENDAR
This is a standard month calendar showing a list of events within the day blocks.    A 
block can display about five events; if there are more events for a day, a scroll bar 
attaches to the block so that you can scroll.

Because of the limited space in the block, event times and CrossKeys are not 
displayed; if there are CrossKeys, a bracketed asterisk (*) appears before the event.

There are small buttons down the left side of the screen with the letter W.    
Selecting one of these buttons will call the Week Calendar for the week to the 
immediate right of the button.

Clicking the mouse on the day of the month (the number) in the block will call the 
Day Calendar for that date.

Clicking on an event in the block will call the QUICKVIEW window for that event; 
double-clicking will call the EVENT WORKSHEET.

OTHER ACTIONS YOU MAY TAKE:

- Call Selection Criteria, CrossKey Maintenance, the Year 
Calendar, or Preferences screens by selecting the appropriate action button 
above the calendar.    

- Print the calendar by selecting the Print button.

- Select the LEFT or RIGHT arrow buttons at the top to move backward or 
forward one month.

- Add a new event by selecting the Add Event button near the lower right 
corner of the screen.

- Return to the previous screen by selecting the EXIT button.



WEEK CALENDAR
The week calendar has seven columns, one for each day of the week, with seven 
boxes in each column for events.

The event box will contain the times for the event, or the braced words {no time}, 
the event CrossKey list, and as much of the event as can be displayed in the box.

If there are more than seven events for a day, a button will appear at the bottom of 
the column with the word MORE, which, when selected, will display up to seven 
more events.    After the last events are displayed, the next click on MORE will 
display the beginning again.

At the top of each column, beneath the day of the week, is a button with the 
calendar date on it.    Selecting one of these buttons will call that Day Calendar.

Clicking an event box will call the QUICKVIEW window for that event; double-
clicking will call the EVENT WORKSHEET.

OTHER ACTIONS YOU MAY TAKE:

- Call Selection Criteria, CrossKey Maintenance, the Year 
Calendar, the Month Calendar, or Preferences screens by selecting the 
appropriate action button above the calendar.    

- Print the calendar by selecting the Print button.

- Select the LEFT or RIGHT arrow buttons at the top to move backward or 
forward one week.

- Add a new event by selecting the Add Event button near the lower right 
corner of the screen.

- Return to the previous screen by selecting the EXIT button.



DAY CALENDAR
The day calendar display all of the events scheduled for the day, according to the 
current SELECTION CRITERIA.    It displays up to four events at a time.    If there are 
more than four events for the day, the words MORE EVENTS will appear at the 
bottom of the screen, with UP and DOWN arrow buttons which will let you move 
forward and backward.

At the left of each event is a button with a number representing its place in the 
order for the day.    (Events with no time specified will be placed first.)    Selecting 
that button will display the EVENT WORKSHEET for the event.

OTHER ACTIONS YOU MAY TAKE:

- Call Selection Criteria, CrossKey Maintenance, the Year 
Calendar, Month Calendar, Week Calendar, or Preferences screens by 
selecting the appropriate action button above the calendar.    

- Print the calendar by selecting the Print button.

- Select the LEFT or RIGHT arrow buttons at the top to move backward or 
forward one day.

- Add a new event by selecting the Add Event button near the lower right 
corner of the screen.

- Return to the previous screen by selecting the EXIT button.



LINKING TO CALLSTAR

                                                                                                                        

Version 2 of PlanStar provides a capability that has been requested by many users: 
the ability to create lists of people - normally external to your organization - and link
the list to a scheduled event.    By normally external, I mean that you should not 
confuse this with the PlanStar CrossKey function, which will associate internal 
resources with events.    So, if you have chosen to create as CrossKeys your 
employee names, and tag them to events, an external link would be entirely 
different.

An external link list would be a list of names and addresses from your CallStar 
directory...if you have CallStar loaded in the PlanStar subdirectory.    (See Installation.)

Heres one example of how PlanStar and CallStar could be used together:

You work for a business education facility teaching a curriculum of business-type courses.    
There are several tracks such as accounting, advertising, computing, etc.    Your job is to plan 
future class sessions and publicize it to potential attendees - people who have attended other 
courses in the same track.    

Let PlanStar handle the scheduling part of it, by assigning a classroom, instructor(s), necessary 
equipment such as computers, etc., and assuring you of no conflicts for any of them for the time
period.

Once youve scheduled the class, CallStar steps in and handles the notification part.    Because 
you have recorded past attendees in track lists (youre maintaining a list named COMPUTER for 
those people interested in computer courses), a couple of mouse clicks and you have a listing 
and/or a stack of mailing labels.

Now you would use PlanStar to create a link between the scheduled course and the 
COMPUTER list (actually CallStar would create a copy of the list as the link, for you to work 
with).

As the people responded, you could record their intentions in contact history for the link list.    
You could also add new names to the COMPUTER list if necessary.

When the deadline arrived, you would then trim the link list down to actual attendees and use it 
for sending out course materials, maintaining a class roster, etc.

Since all the information remains in the PlanStar and CallStar dynamic databases forever - 
unless you purposely delete - you have a permanent record of all class attendees, by session. 
You can later, for instance, select an individual and request a summary of all classes that he or 
she has taken.    With one mouse click.



CREATING THE LINK TO CALLSTAR

There is only one way to get to CallStar from PlanStar, and thats via the Quickview screen.    
So an event must be created as is normally done.    Then, when you return to the EventLog 
screen, the line containing the event will have a letter C (for CallStar!) in the far left column.

NOTE: The EventLog columns are determined at load time.    When loading, if CallStar is 
present, the additional EventLog column is created.    It will not appear if CallStar is not present.

Bring up the Quickview screen by clicking on the line with the C.    At the right of the screen is a 
large box titled Link to CallStar.    If a link exists, a button with the words EDIT LINK is visible, 
and a box below where you can view the names on the list; if a link does not exist, the button 
has the words CREATE LINK.    Clicking the button in either case will summon the CallStar 
List Manager.    



THE CALLSTAR LIST MANAGER
This screen will show the event (possibly truncated) in large letters across the top of the screen. 
The panel below contains all of the entries in your current CallStar directory.    If you are in EDIT 
LINK mode, the selected names for the list are highlighted in the directory.    You may now 
remove or add names as you wish.

On the left side of the Directory panel are some option buttons that let you change the SORT 
ORDER of the directory.    This is let you quickly locate entries, or isolate groups of entries for 
easier selection.    

Below the sort order options is a small box with the words ALL or SELECTED.    If ALL is 
chosen, then all directory entries are displayed, selected or not.    If SELECTED is chosen, then 
only the entries on the current list are displayed.

When your list contains all of the names you need, select SAVE.    

When you EXIT the List Manager, you will return to the Quickview screen.    The new list will be 
displayed.

Then, when you return to the EventLog, the event will sport the C in the leftmost column.

USING LISTS FOR REPORTS AND/OR LABELS

It is not possible in this version (it will be in a later one!) to print a report or set of 
labels for the linked list.    You must execute CallStar to do this.      One of the options 
on the CallStar Print Module screen allows you to display all PlanStar linked lists.



PRINTING
PlanStar will print the current EventLog, the Year Calendar, the Month 
Calendar, the Week Calendar, and the Day Calendar.    All printing is done 
from the...

PRINT MODULE

The PRINT MODULE may be called from the Print Menu, where you can select to 
print Today's Schedule (the Day Calendar for the current day), the current EventLog,
the current Year Calendar, the current Month Calendar, or the current Week 
Calendar.    

Printing may also be initiated from any of the PlanStar screens, by selecting the 
Print action button; this will load the PRINT MODULE with whatever time period is
currently being displayed.

The frame making up the biggest part of the bottom half of the window titled 
Current Selection Criteria displays the settings as you have previously selected.    
You may change these settings for the purpose of this printout, by clicking the 
button labeled CHANGE in the upper right corner of the frame.

Select the printout desired by clicking on the radio buttons on the upper left side of 
the window.    Notice that the corresponding period description appears to the right 
of the calendars, with more detail offered for the EventLog.

PRINTING THE EventLog

The default heading for the printout appears as Events for {beginning date} thru 
{ending date}.    You may modify the heading to say anything you please.

The EventLog can be printed in two formats:

- DESCRIPTIVE.    All of the event data is printed in a rectangular box.    The 
event description is printed complete, wrapped if necessary.    This method would 
primarily be used when printing the EventLog as a schedule.

- COLUMNAR.    Each event is printed on a single line on the page, with the 
date, CrossKeys, event description, actual hours, and amount fields in columns.    
This method would primarily be used for preparation of a report, in the type system 
where accumulation of hours and/or money are being tracked.

PRINTING THE CALENDARS

The year calendar printout is an image of the PlanStar Year Calendar screen.

The other calendars are formatted block printouts.    Each element of the calendar, 
such as a particular day on the Month Calendar, is restricted in size so that the 



entire calendar can fit on a single page.    This may result in data for an element to 
be truncated.    If this occurs, you must print out the next level of calendar for that 
period.    For instance, if there is too much data to print in a box for a day on the 
Month Calendar, you must print a Week Calendar in order to view the entire days 
events.    Or Day Calendar, if necessary.

                                                                                                                                        ***

Printing will be directed to the printers which you have assigned using the Windows 
Print Manager.    If the option box labeled EXPRESS PRINT is marked with an X, the 
printout goes directly to the Windows default printer; if it is not, the standard 
Windows dialog box appears, allowing you to redirect the printout.

NOTE: All printouts are in PORTRAIT format.    Do not select the LANDSCAPE format 
on the dialog box.



RESOURCE UTILIZATION CHARTS
Creating a graphic representation will give you a quick view of resource utilization, 
allowing you to spot trends, level responsibilities, etc.

SELECTING THE CHART CRITERIA

Before displaying the resource chart, you must establish several criteria at the top 
of the screen.    NOTE: THIS CRITERIA SETTING IS NOT RELATED TO THE PLANSTAR 
SELECTION CRITERIA.    

Selecting CrossKeys:

You must select at least one CrossKey(two if you are producing a graph BY 
CROSSKEY).    The TOGGLE ALL button will mark or unmark all CrossKeys 
depending upon the status of the first CrossKey.

SUMMARY OF and BY elements:

There are two dropdown boxes, one listing the "SUMMARY OF" elements and the 
other, the "BY" elements.    (As an example, this is stated as "summary of Events by 
Year".)    The elements and their meanings are as follows:

SUMMARY OF
----------
Events      A count of the selected events.
Event/days  A count of days for selected events.
Hours       Totals of hours for selected events.
{Amount 1}  Totals of the first amount field.
{Amount 2}  Totals of the second amount field.
{Amount 3}  Totals of the third amount field.

NOTE: if the amount fields have been renamed in PREFERENCES, the new names 
will appear in this dropdown list.

 BY
--------
CrossKey  Totaled for each selected CrossKey.
Day       Totaled for each day in the date range.
Week      Totaled for each week in the date range. 
Month     Totaled for each month in the date range.
Year      Totaled for each year in the date range.

NOTE: there must be at least two of whatever is chosen to be the BY element.    In 
other words, if you select BY CROSSKEY, you must select two CrossKeys to 
summarize.    See below for how PlanStar works when BY (time period) is selected.



Date range:

PlanStar will summarize only events falling in the selected date range.    

Since you must select at least two of the BY elements (see note above), PlanStar 
will ensure that you have done this properly by adjusting the date range for you, as 
follows:

- If you select BY DAY, and the date range does not specify at least two days, 
the ending date of the date range will adjust to satisfy this requirement.

- If you select BY WEEK, the beginning date must fall on a Sunday and the 
ending date must fall on a Saturday, because that is considered to be the week 
span.    The dates will adjust to this automatically.    If the date range does not 
specify at least two weeks, the ending date will adjust to cover a two-week period.

- If you select BY MONTH, the beginning date must fall on the first day of a 
month and the ending date must fall on the last day of a month.    The dates will 
adjust to this automatically.    If the date range does not specify at least two months,
the ending date will adjust to cover a two-month period.

- If you select BY YEAR, the beginning date must fall on January 1, and the 
ending date must fall on December 31.    The dates will adjust to this automatically.   
If the date range does not specify at least two years, the ending date will adjust to 
cover a two-year period.

There is a difference in the way charts are produced BY CROSSKEY and BY (time 
period).    A chart produced BY CROSSKEY will create a plot point for each CrossKey 
you have selected; a chart produced BY (time period) will create a plot point for 
each day, week, month, or year in the range, summarizing for all CrossKeys.

CHART TYPES:

You may select to display your graph as a line, vertical bar, or horizontal bar chart, 
with the bar charts either two-dimensional or three-dimensional. 

DISPLAY THE CHART

When all of the criteria has been set to your satisfaction, select the DRAW CHART 
button to the right of the criteria settings, and the graph will be displayed.    If there 
are any errors or inconsistencies in the criteria, a dialog box will be displayed and 
you will have to correct the error.



SETTING PREFERENCES
You may change some of the ways PlanStar works or displays data on the 
PREFERENCES screen.

CHANGING THE TIME DISPLAY FORMAT

This lets you to have times displayed and printed in either the 12-hour clock (with 
AM/PM), or the 24-hour representation.

CHANGING THE EVENT WORKSHEET DEFAULT TIME SETTING

You have the option of having the blank EVENT WORKSHEET display either (1) No 
time, (2) the current time-of-day, or (3) 8:00 AM.

CHANGING THE AMOUNT FIELD NAMES

When PlanStar is first installed, the amount fields are named AMOUNT 1, AMOUNT
2, and AMOUNT 3.    You may change these to any other description you desire.    
The new fields will be displayed properly on all screens and printouts.

CHOOSING TO MARK RECURRING EVENTS

You may choose to mark recurring events in the EventLog and calendars with <R> 
in the event description.    This allows you to quickly distinguish between recurring 
and onetime event types.



PLANSTAR TUTORIAL
We have designed PlanStar to be very easy to use, but include a tutorial for those 
people who like to get a quick look rather than delving through instructions!

This tutorial runs automatically when you first install the system; thereafter, simply 
select TUTORIAL from the HELP MENU.

It is not an interactive demo, just some pop-up windows that explain some of the 
finer points.    To advance, click on the NEXT SCREEN button.



CALLSTAR DEMO
If you dont have CallStar already, and would like to get a feel for what it is, select 
CALLSTAR DEMO from the HELP MENU.    This is a series of screen images with some 
brief explanations.    They are not interactive; you simply click the button captioned 
NEXT SCREEN in the lower right corner until you reach the end.

NOTE: The screen images are .BMP files which have been compressed into a single 
file.    Each time you run the demo, the file will be de-compressed.    You must have 
at least 1.7 megabytes of disk space available in order to do this.



 TECHNICAL SUPPORT
Technical support is available via any of the following methods:
Mail:    ComputerEase

7204 John Elizabeth Place
Prince George, VA    23875

Phone:             (804) 458-2212     (5 - 10 PM EST, answering 
machine at all other times)
CompuServe:  Doug Patrick  (71221,2766)
Internet:            71221.2766@compuserve.com
I much prefer that you use email to contact me, if you have that capability, 
because you are more likely to reach me - I have a day job! - and it provides 
a permanent record of the problem, date and time without anyone having to 
take notes.    I check my email at least once a day.    Please be specific in your
request!
 
Tech support is provided for all users; registered users of CallStar have 
priority.



HOW TO ORDER PLANSTAR

SINGLE-COPY PRICE        $49    To order, select HOW TO ORDER from the HELP
menu.    If you want to order by mail, click on the ORDER FORM button and edit the 
form in your Windows NOTEPAD, then print.

A license for PlanStar entitles you to unlimited use of the system forever, technical 
support for as long as we are in operation (and that depends upon your support!), bug 
fixes on demand, and FREE upgrades.    Free, that is, providing you accomplish your 
own downloads* of newer versions.    We will send you an upgrade on diskette for 
the payment of $5 shipping/handling - paid by check directly to ComputerEase 
only.

*Newer versions will be found in many locations - our primary repositories are on 
Compuserve in IBMAPPS and WINSHARE.    The version number on most BBS can be 
determined by the file name: it will be PSTARxxx.ZIP where xxx equals the version 
number (i.e. PSTAR234.ZIP would be version 2.34).    On Compuserve it will be 
PSTARx.ZIP - they only allow for a 6-character file name.    At the time of this writing, 
plans are being made to have current versions of PlanStar available on the Internet and 
accessible via anonymous FTP.    Give us a call, or preferably, send us an email, to 
determine availability at the time needed.    

NOTE: Downloading and installing a newer version will not remove or affect your 
licensing information. 

For single copies, mail or fax your order to:
Henning Associates
Rt. 2, Box 526-A
Crozet, VA    22932

    AND    

Telephone: 1-800-823-6896 or (804) 823-6896
                                      You may FAX to the same phone numbers!

For purchase of multiple copies, you must contact ComputerEase directly (see 
Technical Support).    The chart below shows the reduced price per copy for quantities 
greater than 5.



BULK PURCHASE:   COPIES          Per copy
                   1- 5             $49
                   6-20             $40
                  21-50             $32
                  51+               $26



ASSOCIATION OF SHAREWARE 
PROFESSIONALS

ASP OMBUDSMAN STATEMENT

This program is produced by ComputerEase, a member of the Association 
of Shareware Professionals (ASP).    ASP wants to make sure that the 
shareware principle works for you.    If you are unable to resolve a shareware-
related problem with an ASP member by contacting the member directly, 
ASP may be able to help.    The ASP Ombudsman can help you resolve a 
dispute or problem with an ASP member, but does not provide technical 
support for members products.    Please write to:

ASP Ombudsman      
545 Grover Road    
Muskegon, MI 49442
or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
- 70007,3536.    The Internet address is 70007.3536@compuserve.com.



WARRANTY DISCLAIMER
ComputerEase makes no warranty of any kind, expressed or implied,
including, without limitation, any warranties of merchantability 
and/or fitness for a particular purpose, other than to guarantee 
that this product, at the time of its creation, was delivered in 
good faith.  ComputerEase shall not be liable for any damages, 
whether direct, indirect, special, or consequential arising from 
a failure of this program to operate in the manner desired by the
user.  ComputerEase shall not be liable for any damage to data or
property which may be caused directly or indirectly by use of the
program.  IN NO EVENT WILL ComputerEase BE LIABLE TO YOU FOR ANY 
DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER 
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OR 
INABILITY TO USE THE PROGRAM, OR FOR ANY CLAIM BY ANY OTHER 
PARTY.




